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Introduction 
 

This guide is intended for use as a field help guide for factory-trained technicians when 
performing a startup on the Pneumercator TMS Series tank gauging system. You can use this 
guide for both the TMS2000 and TMS3000 consoles. The first part of this guide shows what is 
needed to perform a startup on a FACTORY PREPROGRAMMED TMS Series console. The 
second part has the basic wiring needed for the TMS2000 & TMS3000 systems. For detailed 
installation instructions please refer to the appropriate TMS Installation Manual. For systems 
NOT factory preprogrammed, please refer to the standard TMS Operations Manual for 
programming instructions. Please make sure that the Warranty Startup paperwork is completely 
filled out by a factory authorized technician and returned to Pneumercator in a timely fashion to 
qualify the system for warranty consideration. 

 
For information on becoming a factory authorized service/startup technician, please contact 

Pneumercator below, or e-mail at training@pneumercator.com. Your local Pneumercator sales 
representatives may also be of assistance. 
 

This guide is for reference purposes only. Complete installation guidelines are contained in 
the TMS2000 & TMS3000 Installation manuals. 
 
 
 
 
 
For more information, please contact: 
 
 
 
 
 

Pneumercator Co. 
120 Finn Court 

Farmingdale NY 11735 
(631) 293-8450 

Fax (631) 293-8533 
Toll Free (800) 209-7858 
www.pneumercator.com 
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Startup of Preprogrammed systems 
 

This section is for the startup of systems that have been preprogrammed at the factory with 
information supplied by the customer/distributor. 

IT IS THE RESPONSIBILITY OF THE STARTUP TECHNICIAN TO VERIFY THE 
INFORMATION PROGRAMMED INTO THE TMS SYSTEM MATCHES THE SITE 
REQUIREMENTS. IF ANY INFORMATION IS NOT CORRECT, THEY SHOULD CORRECT THE 
PROGRAMMING PER THE OPERATIONS MANUAL OR CONTACT THE FACTORY FOR 
PROGRAMMING ASSISTANCE. 

All systems are supplied with factory configuration sheets showing what was programmed into 
the TMS system. Please review these sheets prior to continuing. 

1. Verify the list of equipment matches what is found on the packing list. 

2. Record probe serial number(s), model number(s), calibration factor(s) (Probe C.F.), and 
length(s) on the worksheet on Page 2. This information must match the factory programming 
printout provided with the console to avoid reprogramming the console. 

 

 

 

 

 

Figure 1 – MP45xS Label Figure 2 – MP46xS Label 

MODEL

PROBE C.F.

LENGTH

SERIAL No.
MP

PNEUMERCATOR
Liquid Level Control Systems

F1234TM-1

450S

9.128

100

SERIAL NUMBER: F1234TM-2

P/N: 7100 V 434 T1 X F2 L460

PROBE CAL. FACTOR: 9.104

PROBE TYPE: MP463V

PROBE LENGTH: 446"

PNEUMERCATOR
Liquid Level Control Systems

3. Stick tanks for product level & water level and record on the worksheet on Page 2. 
Note: Stick readings should be taken where the TMS probe is installed for greater accuracy. 
There must be measurable product in the tank for the stick readings to serve a purpose. 

4. Check wiring and confirm probes & sensors are installed in accordance with the appropriate 
Installation Manual. (See Figures 9-11) 

5. Confirm there are two (2) 12 AWG wires connected to the IS ground terminals going to the main 
circuit panel ground buss bar. (See Figure 8) 

6. Confirm TMS system is on a separate circuit breaker. (See Figure 8) 

7. Power up TMS. 

8. Observe and record any alarms or errors. Power fail alarm is normal on startup. 

9. Check tank reading and compare INCH LEVEL (product height) with results from step 3 above. 
Record difference on the worksheet on Page 2. 

10. Record water reading from TMS & compare with Step 3 above. Record difference on the 
worksheet on Page 2. 

11. Program float height offsets. 
Note: If programming via the front panel buttons is desired, skip to Page 5. 
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Probe Worksheet 
 
 Ex: F1 Probe 1 Probe 2 Probe 3 Probe 4 Probe 5 Probe 6 

Probe Information 

Serial # F1234TM-1       
Model # MP450S       
C.F. 9.128       
Length 100”       

Product Level Information 

Stick 42.5”       
TMS 43.7”       
Prod HO -1.2”       

Water Level Information 

Stick 0.0”       
TMS 1.7”       
H2O HO* -1.5”       
  

 Ex: F2 Probe 7 Probe 8 Probe 9 Probe 10 Probe 11 Probe 12 

Probe Information 

Serial # F1234TM-2       
Model # MP463V       
C.F. 9.104       
Length 446”       

Product Level Information 

Stick 242.5”       
TMS 224.7”       
Prod HO +17.8”       

Water Level Information 

Stick 0.0”       
TMS 5.5”       
H2O HO* -5.0”       

 
*Note: The final water level should be set to at least 0.2” for MP45xS or 0.5” for MP46xS to allow for 
thermal expansion and/or contraction of the system. The MP46xS Series probes should be allowed 
to settle for a couple of days before performing the float offset adjustments. If this is not feasible, 
adjust the final water level to 1.0” to allow for probe straightening/settling. If the TMS has a negative 
water level calculation, the Water alarm will immediately activate. 
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Programming Float Height Offsets using TMS Communicator 
 
1) Install TMSComm on your computer. 

a. Insert TMSComm CD-ROM and follow on-screen instructions. 
Note: if upgrading from a previous version of TMSComm, be sure to run the Site Update 
Utility after installation is complete. 

 
2) Start TMSComm by clicking on Pneumercator in the Start menu under Programs or All 

Programs and then clicking TMSComm. 
 
3) Sign into the TMSComm Administrator account. 

a. Click on the Options menu and click on the Security tab. 
b. Click the Login… button and enter the User Name and Password. 

User Name: ADMIN Password: ROBUST 
Note: the password for TMSComm before version 94 is JONESTOWN. 

 
4) Create a Site to connect to. 

a. Click on the Sites menu and click Select Sites. 
b. Click the New Record button. 

Note: If you already have a site configured, simply select the site by clicking on its name 
and clicking the Close button. Proceed with Step 5. 

c. Enter a Site Name. 
d. Verify the settings below Site Name match Figure 3. 

Note: COM Port must be set according to your computers hardware settings. 
e. Click the Close button. 

 

 
 

Figure 3 – TMSComm Direct Connect Site Default Settings 
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5) Connect to the Site by clicking Connect in the Sites menu. 
 
6) Read the configuration from the TMS. 

a. Click on the Configurations menu. 
b. Click on the File menu in the Configurations window and choose Read Configuration 

From TMS. 
 
7) Verify the Probe Information from the worksheet on Page 2 matches the data entered in the 

Probe section of the Tanks tab in the Configuration window. If this is correct, proceed to the next 
step. If this is not correct, make the appropriate changes, proceed to Step 10, then return to 
Step 8. 

 
8) Enter the Height Float Offset (HO) information from the worksheet on Page 2 as shown in 

Figure 4 for both the Product and Water floats. 
 
9) Click the close button. 
 
10) Click on the File menu and select the Write configuration to TMS option. 

 

 
Figure 4 - TMSComm Probe Configuration Window 
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Programming Float Height Offsets using TMS Front Panel 
 

Refer to the Figure 5 below for the relative locations of the buttons. Note that each button has three 
labels depending upon your display status. Without entering programming mode, the main labels 
printed on the buttons are used. Once in programming mode, a nonflashing display represents 
Review Mode where a flashing display represents Edit Mode. Note that this represents the latest 
front panel button configuration available. Earlier systems maintained the same labeling system but 
had physically different buttons. 

 

DWG NO. 20043 REV. N/C

REVIEW
EDIT

STEP GROUP SELECT EDIT

TESTMODE
TANK 

SELECT

 
Figure 5 - TMS Front Panel Keys Layout (TMS3000 colors shown) 

 
1) Enter programming Mode by pressing and holding the TEST button and then pressing the 

MODE button at the same time until Log (Log) appears. Release both buttons. 
 
2) Press the EDIT (TEST) button repeatedly until Config (Config) appears flashing. 
 
3) Press the ► (MODE) button one time. Header (Header) appears. 
 
4) Press the EDIT (TEST) button repeatedly until Probe (Probe) appears flashing. 
 
5) Press the ► (MODE) button one time. The value for Probe CF for Tank Channel 1 is displayed. 
 
6) Press the GROUP SELECT (TANK SELECT) button until the desired Tank Channel number is 

displayed over the TANK ID label on the display. 
 
7) Press and hold the STEP (MODE) button until it beeps ONE TIME and immediately release the 

button. Repeat this twice more and Prod HO (Prod HO) will appear briefly then the current value 
for the Product Float Height Offset will appear. Note that this number will start with a + (+) or a - 
(-) sign indicating a positive or negative number. 
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8) Press the EDIT ENABLE/THEFT ALARM ACKNOWLEDGE button on the inside of the front 
door up one time. This will NOT cause the display to change but will authorize you to make 
programming changes to the TMS. 

 

DWG NO. 20045 REV. N/C

EDIT ENABLE/
THEFT ALARM
ACKNOWLEDGE

ACKNOWLEDGE
THEFT ALARM
EDIT ENABLE/

PUSH UP AND 
RELEASE

 
Figure 6 - Edit Enable Button 

 
9) Press the EDIT (TEST) button one time and the first digit (cursor) will start flashing. This digit 

indicates a positive or negative number. Use the ▼ (GROUP SELECT) and/or ▲ (TEST) 
buttons to change the value of what’s flashing. Use the ► (MODE) button to move the cursor to 
the right. Once the last digit is flashing the correct value, enter by pressing the ► (MODE) 
button. It will stop flashing and show you the current value for the Product Float Height Offset. 

 
10) Press and hold the STEP (MODE) button until it beeps ONE TIME and immediately release the 

button. h2o HO (H2O HO) will appear briefly then the current value for the Water Float Height 
Offset will appear. Note that this number will start with a + (+) or a - (-) sign indicating a positive 
or negative number. 

 
11) Press the EDIT (TEST) button one time and the first digit (cursor) will start flashing. This digit 

indicates a positive or negative number. Use the ▼ (GROUP SELECT) and/or ▲ (TEST) 
buttons to change the value of what’s flashing. Use the ► (MODE) button to move the cursor to 
the right. Once the last digit is flashing the correct value, enter by pressing the ► (MODE) 
button. It will stop flashing and show you the current value for the Water Float Height Offset. 

 
12) Press and hold the STEP (MODE) button until it beeps TWO TIMES and immediately release 

the button. Return (Return) appears. 
 
13) Press the EDIT (TEST) button two times. Probe (Probe) will appear flashing on the display. 
 
14) Press the GROUP SELECT (TANK SELECT) button until Return (Return) appears flashing. 
 
15) Press the ► (MODE) button one time. Config (Config) appears. 
 
16) Press the EDIT (TEST) button until Return (Return) appears flashing. 
 
17) Press the ► (MODE) button one time. The system returns to normal operating mode. 
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TMS Front Panel Navigation Chart 
 

View

View Tank Contents:

Press and release MODE

Change Displayed Units:

Hold MODE until one beep

View Different Tank Number:

Press and release TANK SELECT

Enable / Disable Autocycle Tank Number:

Hold TANK SELECT until one beep

Review Mode (no flash)

View Parameter Name:

Press and release STEP (MODE)

View Next Parameter:

Hold STEP (MODE) until one beep

Advance to End of Menu (RETURN)

Hold STEP (MODE) until two beeps

Change Group ID:

Hold GROUP SELECT (TANK SELECT)

Change Parameter Value (EDIT MODE):

Press and release EDIT (TEST)

Note: EDIT MODE cannot be entered from this menu

unless EDIT ENABLE has been pressed.

Note: Pressing EDIT while RETURN is displayed

returns you to the previous menu.

Edit Mode (flashing)

Accept Flashing Value:

Press and release � (MODE)

Note:

Numeric values typically change one digit at a time.

"Press and release � (MODE)" will cause the digit to

the right to flash. When the right-most digit flashes,

"Press and release � (MODE)" will enter this value.

Note:

Text values flash all at once.

"Press and release � (MODE)" will enter this setting.

Decrease Parameter Value:

Press and release � (TANK SELECT)

Increase Parameter Value:

Press and release � (TEST)

VIEWACCESS
While holding the test button, hold the mode button until LOG is displayed.

SYSTEM TEST
While holding the test button, all internal visual and audible annunciators are tested.

TMS Navigation Flowchart Vxx0005

RETURN

product TEMPerature

H2O HeighT

Percent VOLume

NET VOLume

GRoss VOLume

PRODuct HeighT

TANK ID

PRODuct TYPE

TANK NAME

time (HH'MM)

date (MM-DD)

INVENTORY

Review Mode (no flash)

Edit Mode (flashing)

Display Parent Menu Title:

Press and release STEP (MODE)

Enter Navigation Mode (EDIT MODE):

Press and release EDIT (TEST)

Accept Flashing Menu (Review Mode in Child Menu):

Press and release � (MODE)

Navigate Down Menu List:

Press and release � (TANK SELECT)

Navigate Up Menu List:

Press and release � (TEST)

Note: Pressing EDIT while RETURN is displayed

returns you to the previous menu.

INVENTORY

(36 - 1 tank per entry)

DELIVERY

(12 - 1 tank per entry)

bulk SALES

(24 - 1 tank per entry)

THEFTS

(6 - 1 tank per entry)

product ORDERS

(1 per tank)

WATER removal

(1 per tank)

in-TANK LEAK test results

(1 per tank)

in-tank LEAK test HISTory

(14 per tank)

ALARMS

(24)

EVENTS

(8)

RETURN

in-tank LEAK

TEST scheduling

CLOCK

INITialize DATA

RETURN

LOG

CONFIGuration

Navigation-Level Parameter-Level

 
 

Figure 7A - TMS Front Panel Navigation Chart - Legend 
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INVENTORY

(36 - 1 tank per entry)

DELIVERY

(12 - 1 tank per entry)

bulk SALES

(24 - 1 tank per entry)

THEFTS

(6 - 1 tank per entry)

product ORDERS

(1 per tank)

WATER removal

(1 per tank)

in-TANK LEAK test results

(1 per tank)

in-tank LEAK test HISTory

(14 per tank)

ALARMS

(24)

EVENTS

(8)

RETURN

VIEW

in-tank LEAK

TEST scheduling

CLOCK

INITialize DATA

RETURN

LOG

CONFIGuration

ACCESS
While holding the test button, hold the mode button until LOG is displayed.

SYSTEM TEST
While holding the test button, all internal visual and audible annunciators are tested.

� context sensitive parameter
TMS Navigation Flowchart Vxx0005

RETURN

INITialize

INITialize DATA

RETURN

DAY of the week

time (HH'MM'SS)

date (MM-DD-YY)

CLOCK

RETURN

CONTROL

SCHeDule DD

SCHeDule RATE

SCHeDule TYPE

START TIME

TEST LENgth

in-tank LEAK TEST scheduling

RETURN

DETAIL

EVENT ID

INPUT ID�

TANK ID�

WARNing NUMber�

ERROR NUMber�

time (HH'MM)

date (MM-DD)

EVENTS

RETURN

DETAIL

ALARM ID

INPUT ID�

TANK ID�

GROUP NUMber�

ALARM

time (HH'MM)

date (MM-DD)

ALARMS

RETURN

RESULT

RATE GPH

LEAK LIMIT

ENDing TIME

STARTing TIME

date (MM.DD.YY)

PRODuct TYPE

TANK NAME

TANK ID

in-tank LEAK test HISTory - tank #

RETURN

RATE HouR 8

RATE HouR 7

RATE HouR 6

RATE HouR 5

RATE HouR 4

RATE HouR 3

RATE HouR 2

RATE HouR 1

RESULT

RATE GPH

LEAK LIMIT

ENDing product TEMPerature

BEGINning product TEMPerature

NET ENDing volume

NET BEGINning volume

TANK ID

PRODuct TYPE

TANK NAME

ENDing TIME

STARTing TIME

date (MM-DD)

in-tank LEAK TEST results 

RETURN

ULLAGE

Percent VOLume

ENDing TOTAL volume

H2O ENDing volume

PRODuct ENDing volume

BEGinning TOTAL volume

H2O BEGINning volume

PRODuct BEGInning volume

TANK ID

PRODuct TYPE

TANK NAME

time (HH'MM)

date (MM-DD)

WATER removal

RETURN

ULLAGE

DAYS LEFT

USEABLE

average DAILY USE (usage)

DAYS since delivery

TOTAL USE (usage)

GRoss volume ENDing

GRoss volume BEGINning

last DELivery AMounT

last DELivery DATE

TANK ID

PRODuct TYPE

TANK NAME

time (HH'MM)

date (MM-DD)

product ORDERS

RETURN

NET volume DIFFerence

NET volume ENDing

NET volume BEGINning

GRoss volume DIFFerence

GRoss volume ENDing

GRoss volume BEGINning

ENDing product TEMPerature

BEGINning product TEMPerature

ENDing product HeighT

BEGINning product HeighT

TANK ID

PRODuct TYPE

TANK NAME

time (HH'MM)

date (MM-DD)

THEFTS

RETURN

NET volume DIFFerence

NET volume ENDing

NET volume BEGINning

GRoss volume DIFFerence

GRoss volume ENDing

GRoss volume BEGINning

ENDing product TEMPerature

BEGINning product TEMPerature

ENDing product HeighT

BEGINning product HeighT

TANK ID

PRODuct TYPE

TANK NAME

time (HH'MM)

date (MM-DD)

bulk SALES

RETURN

NET volume DIFFerence

NET volume BEGINning

NET volume ENDing

GRoss volume DIFFerence

GRoss volume BEGINning

GRoss volume ENDing

ENDing product TEMPerature

BEGINning product TEMPerature

ENDing product HeighT

BEGINning product HeighT

TANK ID

PRODuct TYPE

TANK NAME

time (HH'MM)

date (MM-DD)

DELIVERY

RETURN

product TEMPerature

H2O HeighT

Percent VOLume

NET VOLume

GRoss VOLume

PRODuct HeighT

TANK ID

PRODuct TYPE

TANK NAME

time (HH'MM)

date (MM-DD)

INVENTORY

in-tank LEAK test HISTory - tank 01

in-tank LEAK test HISTory - tank 02

in-tank LEAK test HISTory - tank 12

RETURN

 
 

Figure 7B - TMS Front Panel Navigation Chart - All menus except Configuration 
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HEADER

TANK

PROBE

RELaY TANK

RELaY CC

RELaY SENSor

RELaY SITE

RELaY MODE

CC INPUT

SENSoR INPut

INVENTORY

THEFT

MODEM

DIAL OUT

in-TANK LEAK test

ANALOG OUTputs

RETURN

RETURN

SUNday CLOSE

SUNday OPEN

SATurday CLOSE

SATurday OPEN

Monday - Friday CLOSE

Monday - Friday OPEN

THEFT

RETURN

     SENSoR OFF latch�

     SetPoint 3 OFF latch�

     SetPoint 2 OFF latch�

     SetPoint 1 OFF latch�

LATCH ENable

DELAYed shutoff

Front Panel ACKnowledge

NORMALLY

RELaY MODE

RETURN

reaction TIME DELAY

LOGIC ENable

NORMALLY

USER-defined input NAME�

INPut NAME

CC ENABLE

CC INPUT

RETURN

SATurday ENABLe

FRIday ENABLe

THUrsday ENABLe

WEDnesday ENABLe

TUEsday ENABLe

MONday ENABLe

SUNday ENABLe

HOUR 3 PRinT

HOUR 3

HOUR 2 PRinT

HOUR 2

HOUR 1 PRinT

HOUR 1

INVENTORY

RETURN

TELephone LINE

PAUSE length

DIAL TYPE

BAUD RATE

FaCSimile AREA code

FaCSimile LOCAL phone

MODEM type

MODEM

RETURN

ASSOCIATE with dispensor

ASSOCIATE with tank

NORMALLY

FAULT detect ENable

USER-defined input NAME�

INPut NAME

sensor MODE�

sensor TYPE

SENSOR ENable

SENSoR INPut

RETURN

SYStem ERROR

POWER FAIL

THEFT

RELaY SITE

RETURN

INVentory HOUR�

INVentory DIAL

system ERRor DIAL

SENSor DIAL

CC DIAL

THeFT DIAL

H2O DIAL

SetPoint 3 DIAL

SetPoint 2 DIAL

SetPoint 1 DIAL

LEAK test DIAL

phone LINE TYPE

TELephone AREA code 2

TELephone AREA code

TELephone LOCAL phone

DIAL OUT

RETURN

GENerator TANK leak test mode

UNGAuGEABLe product

UNUSEABLE product

THEFT ENable

VOLUME #�

HEIGHT #�

CONE HeighT�

TANK LENgth�

TANK HeighT�

TANK RISE�

TANK RADius�

MANIFOLD quantity

TANK CAPacity

TANK TYPE

SetPoint H2O� 

H2O ENABLe

SetPoint 3 HORN

SetPoint 2 HORN

SetPoint 1 HORN

SetPoint 3 NAME

SetPoint 2 NAME

SetPoint 1 NAME

SetPoint 3 setting

SetPoint 2 setting

SetPoint 1 setting

PRODuct CODE

PRODuct TYPE

VOLume MODE

TANK ID

USER-defined tank NAME�

TANK NAME

TANK ENable

TANK

RETURN

RISER Gallons Per Inch�

LOG MINimum volume

MOTion height BAND

TEMPerature ENable

PROBE REP rate�

PROBE LOCation offset�

H2O float Height Offset

PRODuct float Height Offset

PROBE LENgth

PROBE TYPe

PROBE Calibration Factor

PROBE

RETURN

H2O TRIGger

SetPoint 3 TRIGger

SetPoint 2 TRIGger

SetPoint 1 TRIGger

LEAK TRIGger

RELaY TANK

RETURN

CC TRIGger

RELaY CC

RETURN

SENSor TRIGger

RELaY SENSor

VIEW

in-tank LEAK

TEST scheduling

CLOCK

INITialize DATA

RETURN

LOG

CONFIGuration

ACCESS
While holding the test button, hold the mode button until LOG is displayed.

SYSTEM TEST
While holding the test button, all internal visual and audible annunciators are tested.

� context sensitive parameter
TMS Navigation Flowchart Vxx0005

RETURN

GAIN

DATA SELect

ANALOG ENable

ANALOG OUTputs

RETURN

ReLaY CoNTRoL�

PUMP-GENerator�

AUTO MODE pass/fail select�

THRESHOLD�

LEAK LIMIT

TEST MODE

TEST ENable

in-TANK LEAK test

RETURN

Daylight Savings Time ENABLe

percent ULLage LIMIT

MONTHLY status report

LEAK PRINT mode

AUTOPRINT enable

HORN shutoff DELAY

bulk SALEs ENable

SetPoint UNITS

TANK QuanTitY

SERIAL ForMaT serial port b

BAUD RATE serial port b

SERIAL ForMaT serial port a

BAUD RATE serial port a

DiSPlay MODE

SITE ID

UNIT ID

communciations SECURITY

ACCess CODE

HEADER

 
 

Figure 7C - TMS Front Panel Navigation Chart - Configuration menu only 
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TMS Wiring Diagrams 
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Figure 8 - TMS AC Power Wiring 



Quick Startup Guide TMS Series 
 

Quick Startup Guide.doc Page 11 of 16 October 31, 2005 

7/
13

/2
00

5 
2:

40
:1

2 
P

M
, 1

:1
, ©

 C
O

P
Y

R
IG

H
T

 2
00

5 
P

N
E

U
M

E
R

C
A

T
O

R
 C

O
M

P
A

N
Y

, I
N

C
.

B
ul

le
tin

 1
99

 R
ev

. N
/C

 (
07

/1
3/

05
)

P
ag

e 
1 

of
 1

P
N

E
U

M
E

R
C

A
T

O
R

Li
qu

id
 L

ev
el

 C
on

tr
ol

 S
ys

te
m

s

NON-INTRINSICALLY SAFE WIRING

INTRINSICALLY SAFE WIRING

H
A

Z
A

R
D

O
U

S
 A

R
E

A
C

LA
S

S
 1

, G
R

O
U

P
S

 C
, D

N
O

N
-H

A
Z

A
R

D
O

U
S

 A
R

E
A

C
O

N
D

U
IT

 A
N

D
 V

A
P

O
R

 S
E

A
L 

F
IT

T
IN

G
 

(S
IZ

E
 A

N
D

 L
O

C
A

T
IO

N
 T

O
 B

E
 

D
E

T
E

R
M

IN
E

D
 B

Y
 Q

U
A

LI
F

IE
D

 IN
S

T
A

LL
E

R
)

R
E

D
U

C
E

R
 F

IT
T

IN
G

(I
F

 N
E

E
D

E
D

)

JU
N

C
T

IO
N

 B
O

X
(P

R
O

V
ID

E
D

 B
Y

 
IN

S
T

A
LL

E
R

)

1/
2"

 N
P

T
 O

R
 E

Q
U

IV
. C

A
B

LE
 G

R
IP

R
E

Q
'D

 O
N

LY
 O

N
 M

P
45

xS
 M

O
D

E
LS

(J
U

N
C

T
IO

N
 B

O
X

 M
O

U
N

T
S

 D
IR

E
C

T
LY

 
T

O
 P

R
O

B
E

 O
N

 M
P

46
xS

 M
O

D
E

LS
)

W
IR

E
 S

P
LI

C
E

 S
E

A
L 

C
O

N
N

E
C

T
O

R
 (

B
Y

 P
C

O
 *

)
F

O
LL

O
W

 S
U

P
P

LI
E

D
 W

IR
E

 S
P

LI
C

E
 IN

S
T

R
U

C
T

IO
N

S
B

U
LL

E
T

IN
 1

79
; K

IT
 P

/N
 1

05
85

-2
 (

F
O

R
 M

P
46

xS
)  

B
U

LL
E

T
IN

 1
81

; K
IT

 P
/N

 1
05

85
-2

L 
(F

O
R

 M
P

45
xS

)
F

IE
LD

 W
IR

IN
G

 C
A

B
LE

 (B
Y

 C
U

S
T

O
M

E
R

)
E

X
A

M
P

LE
: B

E
LD

E
N

 8
44

1,
 A

V
A

IL
A

B
LE

F
R

O
M

 P
C

O
 *

 A
S

 C
W

1-
05

00
 (

50
0'

 S
P

O
O

L)
 

T
M

S
 C

O
N

S
O

LE

T
Y

P
IC

A
L 

T
A

N
K

 
W

/ P
R

O
B

E

G
R

N

R
E

D

B
L
K

F
IE

LD
 C

A
B

LE
 

N
ot

e 
fo

r 
al

l p
ro

be
 m

od
el

s:
 

C
on

du
ct

or
 c

ol
or

s 
m

ay
 v

ar
y 

de
pe

nd
in

g 
on

 c
ab

le
 m

an
uf

ac
tu

re
r.

 
T

he
 fi

el
d 

ca
bl

e 
sh

ie
ld

 w
ire

 m
us

t 
be

 c
on

ne
ct

ed
 to

 th
e 

P
R

O
B

E
 

S
H

IE
LD

 T
E

R
M

IN
A

L 
in

 th
e 

co
ns

ol
e 

I.S
. c

om
pa

rt
m

en
t a

nd
 s

ho
ul

d 
be

 c
ut

 
ba

ck
 a

nd
 le

ft 
un

te
rm

in
at

ed
 a

t t
he

 
pr

ob
e 

ju
nc

tio
n 

bo
x.

W
H

T

B
LK

G
N

D

S
T

U
D

T
O

T
O

T
O

T
M

S
20

00
 P

R
O

B
E

 IN
P

U
T

 W
IR

IN
G

T
M

S
30

00
 P

R
O

B
E

 IN
P

U
T

 W
IR

IN
G

+
V

+
V

S
IG

G
N

D
S

H
D

G
N

D
+

V

21S
H

D
B

LK
R

E
D

C H A N N E L 1

S E N S O R SP R O B E

P
R

O
B

E
 2S
H

IE
LD

G
N

D
+

V
S

H
IE

LD
G

N
D

+
V

S
H

D
B

LK
R

E
D

P
R

O
B

E
 1

T
Y

P
IC

A
L 

W
IR

IN
G

 F
O

R
 T

M
S

 C
O

N
S

O
LE

S

* 
"P

C
O

" 
R

E
F

E
R

S
 T

O
 P

N
E

U
M

E
R

C
A

T
O

R
 C

O
M

P
A

N
Y

.

F
R

O
M

P
R

O
B

E
T

O
 C

O
N

S
O

L
E

(A
S

 S
H

O
W

N
 A

B
O

V
E

)

3/
4"

 N
P

T
 (

T
M

S
20

00
)

1"
 N

P
T

 (
T

M
S

30
00

)
O

R
 E

Q
U

IV
A

LE
N

T
C

O
N

D
U

IT
 F

I T
T

IN
G

W
IR

IN
G

 M
U

S
T

 B
E

 D
O

N
E

 IN
 W

A
T

E
R

T
IG

H
T

 R
A

T
E

D
 B

O
X

/H
O

U
S

IN
G

P
R

O
B

E
 M

O
D

E
LS

C
O

V
E

R
E

D
 B

Y
 T

H
IS

 B
U

LL
E

T
IN

M
P

46
1S

C
M

P
46

1S
V

M
P

46
2S

V
M

P
46

3S
V

M
P

45
0S

M
P

45
1S

M
P

45
2S

R
ef

er
 to

 T
M

S
 in

st
al

la
tio

n 
m

an
ua

l f
or

 
W

A
R

N
IN

G
S

 a
nd

 C
A

U
T

IO
N

S
 b

ef
or

e 
pr

oc
ee

di
ng

. F
A

IL
U

R
E

 T
O

 C
O

M
P

LY
 

M
A

Y
 R

E
S

U
LT

 IN
 P

E
R

S
O

N
A

L 
IN

JU
R

Y
, 

P
R

O
P

E
R

T
Y

 L
O

S
S

 A
N

D
 E

Q
U

IP
M

E
N

T
 

D
A

M
A

G
E

.

IM
P

O
R

T
A

N
T

! 
P

R
O

B
E

 W
IR

IN
G

 IN
S

T
R

U
C

T
IO

N
S

 -
 M

O
D

E
L

S
 T

M
S

20
00

 A
N

D
 T

M
S

30
00

M
P

45
xS

R
E

D

B
L
K

R
E

D

B
LK

T
O

T
O

M
P

46
xS

!
W

A
R

N
IN

G

 
 

Figure 9 - TMS Probe Wiring 
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Figure 10 - TMS2000 Sensor Wiring 
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Figure 11 - TMS3000 Sensor Wiring 
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Figure 12A - TMS Series to RA200 Wiring 
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Figure 12B - TMS Series to RA200 Wiring 
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RA200 Remote Alarm Programming 
 Contact Closure 1 Reset 

Contact Closure 2 Test 
Relay 1 Strobe 
Relay 2 Horn 

 
Note: Refer to Figure12 for a complete 
wiring diagram to a TMS Series. 
 
 The following wiring scenario is being provided as a guideline only. The advantage to wiring 
the CC Inputs as illustrated is to use the Reset switch in combination with the Test switch. The 
relays can be wired in any combination. This is the way your system will be preprogrammed if 
supplied with an RA200 alarm. 
 
Programming: 
 

1. Sets the tank conditions that must occur to activate the relays. 
 

Front Panel  TMS Communicator 
Config Ö Rely Tank  Configuration Ö Relays Ö Tank Triggers 
 Relays   Relays 

Leak Trig no.no.no  Leak Trigger None - None - None 
SP1 Trig 01.02.no  Set Point #1 Trigger Relay #1 - Relay #2 - None 
SP2 Trig 01.02.no  Set Point #2 Trigger Relay #1 - Relay #2 - None 
SP3 Trig no.no.no  Set Point #3 Trigger None - None - None 
H2O Trig no.no.no  Water Trigger None - None – None 

 
2. Chooses the CC Inputs that the relays will react to. 

 
Front Panel  TMS Communicator 

Config Ö Rely cc  Configuration Ö Relays Ö Non-Hazardous Contact Closure Inputs 
cc Trig Relays  CC Trigger Relay Selects 

1 02.no.no  #1 Relay #2 – None – None 
2 01.02.no  #2 Relay #1 – Relay #2 – None 

 
3. Controls the behavior of a relay. 

 
Front Panel 

Config Ö Rely Mode 
Relay Normally FP Ack Delay Latch En 

1 Off No None No 
2 Off Yes None No 

 
TMS Communicator 

Configuration Ö Relays Ö Relay Mode 
Relay Normal Contact State Allow Front Panel Acknowledgements Delayed Shutoff Latch Enable 

#1 Off � None � 
#2 Off ; None � 

 
4. Controls the behavior of a Contact Closure Input. 

Front Panel 
Config Ö cc Input 

CC Input cc Enable Inp Name Normally 
1 Ack Input Open 
2 Relay Input Open 

 
TMS Communicator 

Configuration Ö Contact Closure Inputs Ö Non-Hazardous Contact Closure Inputs 
CC Input Contact Closure Enable Input Name Normally 

#1 Acknowledge Input Open 
#2 Relay Input Open 
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